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Section 1 
 
 
 
 
 
 
Organisation and conditions for assessment 
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Organisation and conditions for assessment 
 
 
The assessment is designed to test the candidate’s ability to apply knowledge and understanding and 
practical skills, developed through study of the Relational Database Systems and Using Information 
units.  The mark out of 60 should be submitted to the SQA unscaled.  This will be combined with the 
examination mark out of 140 to establish the candidate’s overall grade of award.  This mark should also 
be used in conjunction with internal examination marks or other evidence in the preparation of a 
candidate’s estimated grade of performance. 
 
The notional design length for the assessment is 8–10 hours.  However, a candidate may be permitted 
additional time if required. 
 
The assessment is to be undertaken under “open book” conditions, but under the supervision of a 
teacher or lecturer to ensure that the work submitted is the candidate’s own work.  The teacher or 
lecturer may give the candidate guidance and/or help if requested.  Any such help should be reflected in 
the marks awarded.  Once the task has been completed and marked, it should not be returned to the 
candidate for further work. 
 
These instructions are designed to be used in conjunction with data files provided with the electronic 
distribution of the task.  These can be downloaded from the SQA secure website. 
 
Please note special instructions for this years task on pages 6 to 8. 
 

Two versions of a database are being supplied this year.  It is essential that candidates are issued 
with the correct version at the appropriate times.  They must not be given access to the second 
version until they have submitted answers to prior tasks. 
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Special Arrangements for Higher Coursework 2008-09 
 
Centres are asked to pay special attention to the following arrangements. 
 
 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 
prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, Microsoft Access (2000 format) and Filemaker (v.5) as well as text (tab) delimited 
and csv data files have been provided.  It is intended that candidates will be provided with two versions 
of the database. 
 
The first database contains all 4 tables that the candidate will be required to edit as part of  
Task 2.  Each table will have all attributes present but all attributes will be default text type –  
ie no keys, formatting, validations, relationships etc.  The database should not be populated at this 
time.  Candidates will be required to modify the database structure to match the data dictionary issued 
to them at the start of Task 2.  Candidates will be required to submit a printout of the Documenter (or 
equivalent) as evidence for Task 2.  Candidates will not use their database structures to complete Tasks 
3-5.  Instead, centres should issue candidates with the second, fully populated database. 
 
The second database will be a complete implementation of the system.  This will include all 
validations, relationships etc – ie an exact implementation of the data dictionary provided to candidates 
at Task 2.  This working database should be issued to candidates after Task 2 has been submitted.  
Candidates must use this working database to complete Tasks 3-5. 
 
Microsoft Access and Filemaker files are provided.  Centres using other systems will require to create 
both versions of the database from the tab separated and csv files provided.  These files can also be used 
if centres encounter any difficulties with the supplied Access or Filemaker databases. 
 
Additional notes follow which detail how candidate evidence is to be generated. 
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Notes: 
 

Candidates should be given a copy of the marking grid from Section 3 (not the detailed marking 
instructions) before starting the task so that they are aware of the mark distribution for each part. 

The entire Coursework task consists of seven tasks.  Centres should take note of the points detailed 
below for each task. 

• Task 1 can be completed using a hardcopy of the proforma provided or can be produced by the 
candidate.  Task 1 must be completed and data dictionary handed in for marking before 
the materials for Task 2 are issued. 

• Task 2 asks for a “printout or hardcopy of the table structure showing field types and validation 
checks etc”.  This is to provide evidence that the correct field types have been used and all 
necessary validation checks implemented.  Centres should note the additional information in 
the detailed marking instructions indicating acceptable evidence.  Producing this printout 
is NOT part of the task and if a candidate has difficulty then the assessor should help them. 

 
o In FileMaker Pro8, to get a printout of the design, candidates should adhere to 

the following instructions. 
 

(1) Select the “Define” option from the File menu and then select the 
“Database” option from the sub-menu. 

(2) Click on the Tables tab. 
(3) Highlight both tables by clicking on the name of the first table then 

holding down the shift key and clicking on the other table. 
(4) Click on the Print button. 
 

o In MS Access, to get a printout of the design, candidates should adhere to the 
following instructions.   

(1) Select the “Analyze” option from the Tools menu and then select  
the “Documenter” option from the sub-menu. 

(2) Select the table(s) required and then click Options button. 
(3) Make sure that the following options are checked/selected: 

• Include for Table 
 Properties 
 Relationships 

• Include for Fields 
 Names, Data Types, Sizes and Properties 

• Include for Indexes 
 Names and Fields 

(4) Required table design is displayed on screen and can be printed. 
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• Task 2 also requires a printout or hardcopy of the relationships. 

o Printing Relationships in FileMaker 8. 
(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 
(2) Click on the Relationships tab then click on the Print button. 

 
o Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 

 
• Tasks 3-5 must be completed using the complete database created by or provided to the centre.  

Candidates should only be issued with this database after submission of Task 2 evidence. 

• Task 5 requires a further printout of macros/scripts.  Centres should note the additional 
information in the detailed marking instructions indicating acceptable evidence. 

• Task 6(a) can be completed using a hardcopy of the proforma provided or can be produced by 
the candidate. 

• Task 6(b) requires inclusion of 2 articles – the content of article 1 is not being assessed, 
provided it meets the requirements of the task.  The content of article 2 is being assessed and 
should include the issues suggested to candidates. 

• Task 7 requires candidates to produce a report – candidates have been provided with a sample 
layout. 
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Coursework Task: GoGoGadgets.com 
 
 
Higher Information Systems Coursework Task 2008-2009 
 
Background 
 
GoGoGadgets.com is a website that specialises in quirky and unusual gadgets that are available for 
purchase through its on-line catalogue.  Before customers can make a purchase from the website, they 
must first register with GoGoGadgets.  Customer details are stored by GoGoGadgets in a Customer 
table.  On registering, customers are notified by e-mail of their unique customer ID which must be used 
in all future purchases. 
 
GoGoGadgets’ product range is stored in a table called Item and these items can be browsed through an 
on-line catalogue.  Each item is categorised as one of the following: Boys Toys, Girls Gizmos, Office 
Distractions, Personal Grooming and Computer Accessories.  All items cost less than £50. 
 
When placing an order, customers must first log-in and create a new order – this order is added to an 
Order table.  Customers can then add items from the catalogue to an order.  More than one item can be 
added to a given order.  Each individual item ordered is stored in a separate table called OrderLine. 
 
A relational database has been set up to store details of customers, items, orders and order lines. 
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The normalised data model for GoGoGadgets has been produced, as follows.  (Primary keys are shown 
in bold and underlined, while asterisks (*) indicate foreign keys.) 
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Customer  (Customer ID, Forename, Surname, Address1, Address2, Address3, Postcode, Customer_email)
 
Item (ItemID, Description, Category, Price) 
 
Order (Order No, Customer ID*, OrderDate, OrderDispatched) 
 
Orderline (Order No*, Item ID*, Quantity) 
 
The entity-relationship diagram for the system is shown below. 
 
 
 
 
 
 
 
A data dictionary has been produced prior to implementation in a relational database.  Part of this is 
shown overleaf. 

Item Customer Order OrderLine 
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Entity Attribute PK/ FK Data 

Type/Size 
Unique Required Validation Format 

Customer CustomerID PK Number Y Y >=0001 and <=9999 0000 
 Forename  Text (10) N Y   
 Surname  Text (15) N Y   
 Address1  Text (20) N Y   
 Address2  Text (20) N N   
 Address3  Text (20) N Y   
 Postcode  Text (8) N Y   
 CustomerEmail  Text (25) Y A   
Item ItemID PK Number B Y  0000 
 Description  Text (50) N Y   
 Category  Text (20) N Y C  
 Price  Number N Y <50 Currency 
Order OrderNo PK Number Y Y  0000 
 CustomerID FK Number N Y D 0000 
 OrderDate  Date N Y  dd/mm/yyyy 
 OrderDispatched  Date N N  dd/mm/yyyy 
OrderLine OrderNo PK/FK Number E Y Lookup from Order 0000 
 ItemID PK/FK F N Y Lookup from Item 0000 
 Quantity  Number N Y   

 
 
 
For text attributes, the number in brackets indicates the size of the attribute (number of characters).   
 
In the Format column, the symbols 
• 0 represents a single digit  
• d, m and y indicate digits used to represent the day, month and year in a date field 
 
 
 
 
 
 
 
Task Evidence Required 
1 Using the background information provided, complete the data 

dictionary by making appropriate entries in the Task 1 
Proforma. 

Task 1 Proforma 
(Appendix 1) 

 
You must now submit your answer to Task 1 to your teacher/lecturer. 
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Before attempting the tasks in this section ask your teacher/lecturer for a completed data 
dictionary.   
 
You will also need access to pre-prepared database tables.  
 
You MUST complete tasks in the sequence indicated. 
 
 
Task Evidence Required 
2 A database has been set up containing the Customer, Item, Order and OrderLine tables. 
 (a) Edit the structure of each table to ensure it matches the 

data dictionary provided.  You should pay particular 
attention to; 

• primary and foreign keys 
• data type/size 
• unique 
• required 
• validation 
• format 
 

Hardcopy (printout or 
screenshots) of table 
structure including 
field types, validation 
checks etc. 

 (b) Set up/edit the relationships between all the tables as 
indicated by the entity-relationship diagram. 

Hardcopy (printout or 
screenshots) of 
relationships between 
tables. 

 
You must now submit all hardcopies for Task 2 to your teacher/lecturer. 
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Ask your teacher/lecturer for the complete database.  This database must be used to carry out 
Tasks 3-5. 
 
You are an employee of GoGoGadgets.  One of your tasks is to produce invoices for each customer 
which details all of their orders for the finance department.  These invoices need to show all items 
ordered, the individual item totals, the order total and the overall total for all that customer’s order. 
 
A sample invoice for customer Karen Springer is shown below. 

 
 
Task Evidence Required 
3 Using appropriate database functions create an invoice for 

customer Luke Muirhead, customer ID 7853.  The layout 
should be similar to the one shown above.  The data should be 
sorted with the most recent order first. 
 

Printout of 
report/layout 
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GoGoGadgets ran a promotion in the run up to Christmas by offering a 5% discount to the total 
of any order placed in December 2007.  A report was generated so that Head Office could 
analyse the impact of that promotion.  This report is shown below. 
 

 
 
The management of GoGoGadgets then decided to try and boost sales in the quiet period after 
Christmas by offering a 20% discount to the total order price of any order placed in January 
2008.  
 
Task Evidence Required 
4 Head Office want to analyse how effective their January 

promotion has been and have asked you to prepare a report 
similar to the one shown above.  This report must show: 
 

• all orders placed in January 2008 showing the order 
date and order total rather than individual items on the 
order 

• the value of each order’s 20% discount 
• the value of each order after discount 
• a summary field showing the overall monthly total 

before discount 
• a summary field showing the overall total discount for 

the month 
• a summary field showing the overall monthly total 

after discount 
• the number of orders placed in January 2008 

 
The report should be sorted by order date as shown.  Where two 
or more orders are placed on the same day, they should be 
sorted by OrderNo in ascending order. 
 

Printout of 
form/layout 
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A customer satisfaction survey has revealed that customers would like to be able to browse catalogue 
pages organised by category. 
 
 

   
 

Fig (a): Category Selector Form Fig (b): Single Category Form (Girls Gizmos) 
 

 
Task Evidence Required 
5 Use the database to perform the following tasks. 
 (a) Create a Category Selector form similar to the one shown 

in Fig (a) above.  Choose any of the five categories and 
create a navigational link to a separate form that shows 
only items from the chosen category (eg Fig (b)).  
 

Screen shots of 
forms/layouts 

 

 (b) Amend the single category item form to include a link 
back to the Category Selection form. 
 
Each navigational link should close the current 
view/form and open the selected form. 
 

Printout of 
macros/scripts used to 
control navigational 

features 
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The customer care department of GoGoGadgets often send newsletters to customers with details of 
special offers or promotions as demonstrated below. 
 

 
 

You have been asked to create a newsletter for GoGoGadgets to send to their existing customers.  Each 
newsletter has to be personalised for each customer by merging the first name, surname and 
address 3 attributes from the Customer table. 
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Task Evidence Required 
6 (a) The newsletter could be produced using either word 

processing or desk top publishing software. 
Select the most appropriate type of software for creating 
the newsletter and complete the proforma, giving reasons 
for your choice by comparing; 
 

• the functionality of the software, and 
• the usability of the software 
 

You should compare at least two features for each criteria. 
 

Task 6 (a) proforma 
(Appendix 3) 

 (b) The newsletter should include the two articles described 
below. 
 
Article 1 
GoGoGadgets is going to run an Easter promotion 
offering special discounts, Buy One Get One Free deals 
etc.  The article should feature at least two products from 
the Item table and include a graphic of each featured item.  
Body text should wrap around the graphic. 
 
Article 2 
GoGoGadgets want to highlight the advantages that their 
e-commerce operation brings to customers.  The article 
should cover at least three relevant issues such as cost 
savings that can passed on to customers, efficiency, 
accuracy and speed of placing and dispatching orders, 
flexibility of when and where orders can be placed. 
 
In the creation of your publication you should: 

• personalise the newsletter by merging with the 
Customer table from the database (first name, 
surname and address3) 

• include the two articles detailed above 
• use a consistent house style ensuring each article 

has a headline and uses a sans serif font 
• use 14 or 16 point text with a two line drop capital 

for the first paragraph in each article 
• use a 12 point sans serif font for the main text 
• ensure text wraps around any graphics and flows 

between columns 
• ensure that text and graphics fill the space 

available, and there is no unnecessary white space 
 

2 printouts 
 
one printout 
showing newsletter 
with field markers 
 
one printout 
showing merged 
newsletter for one 
customer 
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Business analysts at GoGoGadgets have gathered information regarding its business operations since 
the company was formed in 2002. 
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It has been suggested that the information in its current form is not very well presented. 
 
Head office wants you to prepare a report that includes this information in a more concise form.  The 
report must include information about the number of branches, costs, revenue and profit for the 6 year 
period from 2002–2007. 
 
Task Evidence Required 
7 (a) Using appropriate software, present a summary of the 

information provided by the business analysts in a table.  
The report must include information about the number of 
branches, costs, revenue and profit for the 6 year period 
from 2002–2007. 
 

Printout of report 

 
In addition, Head Office wants a summary of the effectiveness of the January promotion.  The 
sales department gathered data from orders placed in January 2007, where no special discounts 
applied.  A total of 6 orders were placed generating revenue of £496.  Using this data and your 
answer to Task 4, prepare a table that demonstrates how effective the January 2008 promotion 
has been. 
 
Task Evidence Required 
7 (b) In the same document/report, provide a table summarising 

the information provided following the January sales 
promotion.  The table should show, for both 2007 and 
2008, the total number of orders placed and the total 
revenue.  In addition, the table should include the total 
discount for 2008 and the net revenue for 2008. 
 
Following this table should be a statement which 
highlights the key differences between the 2 years and a 
suggestion on how the promotion should be altered for 
January 2009. 
 

Printout of report 

“At the start of 2002, GogoGadgets operated with 35 high street branches as 
well as their on-line operation. In 2002, their fixed costs were £700,000 
whilst revenue for that first year of operation was £763,000. The next year, 
by closing 10 branches and switching those operations to the on-line facility, 
costs decreased by 15% to £595,000 whilst in the same period, revenue rose 
by 8% to £824,040. 2004 saw the closure of a further 5 branches, reducing 
costs by a further £95,000 to £500,000. 2004 also saw revenue rise to 
£900,000. GogoGadgets closed 12 branches in 2005, with costs now running 
at £250,000 but revenue actually dropped to £760,000. A decision was made 
in 2006 to close all high street branches except the store at Head Office with 
the result that costs levelled at £90,250 with revenue for that year of 
£795,000. With the one remaining branch at Head Office and all operations 
now on-line, GogoGadgets’ costs for 2007 were £114,000 with a total 
revenue of £865,000.” 
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The report should be based around the template shown below. 
 

Gogo Gadgets Summary Report

Business operations since 2002

January Promotions

20082007

Concluding Statement
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Marking Grid 
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Marking Grid 
 
 
Name  ____ Date     
 
Part I – Relational Database Systems 
 
Task Topic Possible

Marks 
Marks 
Gained

Evidence Comment 

A 1,0  
B 1,0  
C 1,0  
D 1,0  
E 1,0  

1. 

F 1,0  

Proforma  

Edit Customer, Item, Order and OrderLine 
tables 

4,3,2,1,0  Hardcopy of Database 
solution files  (eg 
Documenter in Access) 

 2. 

Links between tables 2,1,0  Screenshot of relationships  
Computed & Summary fields 3,2,1,0   3. 
Report layout 2,1,0  Hardcopy of report  
Order details 3,2,1,0   
Summary fields 3,2,1,0   

4. 

Report layout 2,1,0  
Hardcopy of report 

 
Forms created 2,1,0  Screenshots of forms  5. 
Navigation features 3,2,1,0  Printout of macros/scripts 

used to control navigation 
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Part II – Using Information 
 

Task Topic 
Possible 
Marks 

Marks 
Gained

Evidence Comment 

Software functionality 2,1,0  6.(a) 
Software usability 2,1,0  

Task 6 (a) Proforma  

Personalised newsletter 2,1,0 

 

Printouts showing field 
markers 
Printout showing sample 
customer 

Consistent house style 4,3,2,1,0  
Newsletter layout 3,2,1,0  
Article 1 4,3,2,1,0  

6.(b) 

Article 2 4,3,2,1,0  

Newsletter  

7.(a) Table/chart 3,2,1,0   
7.(b) Table 3,2,1,0   

 Concluding Statement 3,2,1,0  

Report 

 
 

 Possible
Marks 

Actual
Marks 

Overall Total 60  
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Appendix 1 
 
Task 1 Proforma 
 
 
Name  

 
Data Dictionary Entry 
 

 
A 
 

 

 
B 
 

 

 
C 
 

 

 
D 
 

 

 
E 
 

 

 
F 
 

 

 
 
 



Appendix 2 
 
Completed Data Dictionary 
 
Only to be issued after completion and submission of Task 1 
 

Entity Attribute PK/ FK Data 
Type/Size 

Unique Required Validation Format 

Customer CustomerID PK Number Y Y >=0001 and <=9999 0000 
 Forename  Text (10) N Y   
 Surname  Text (15) N Y   
 Address1  Text (20) N Y   
 Address2  Text (20) N N   
 Address3  Text (20) N Y   
 Postcode  Text (8) N Y   
 CustomerEmail  Text (25) Y Y   
Item ItemID PK Number Y Y  0000 
 Description  Text (50) N Y   
 

Category  Text (20) N Y 
Restricted Choice (Boys Toys, 
Girls Gizmos, Personal 
Grooming, Office Distractions, 
Computer Accessories) 

 

 Price  Number N Y <50 Currency 
Order OrderNo PK Number Y Y  0000 
 CustomerID FK Number N Y Lookup from Customer 0000 
 OrderDate  Date N Y  dd/mm/yyyy 
 OrderDispatched  Date N N  dd/mm/yyyy 
OrderLine OrderNo PK/FK Number N Y Lookup from Order 0000 
 ItemID PK/FK Number N Y Lookup from Item 0000 
 Quantity  Number N Y   
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Appendix 3 
 
Task 6 (a) Proforma 
 
 
Name  

 
Software Evaluation Form 
 

Functionality 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Usability 
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Appendix 4 
 
 
 
 
 
 
 
Detailed Marking Instructions 
 
Strictly Confidential 
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Detailed Marking Instructions – Do not issue to candidates. 
 
1 A 1,0 Y (Customer e-mail required)  
 B 1,0 Y (ItemID unique in Item table)  
 C 1,0 Restricted Choice (Boys Toys, Girls Gizmos, 

Personal Grooming, Office Distractions, Computer 
Accessories) 

 D 1,0 Lookup from Customer entity 
 E 1,0 N (OrderNo not unique in OrderLine) 
 F 1,0 Number 
2 Edit Customer, Item, Order 

and OrderLine tables  
4,3,2,1,0 All 4 tables completely correct (no errors) against 

competed data dictionary provided – 4 marks 
3 tables completely correct – 3 marks 
2 tables completely correct – 2 marks 
1 table completely correct – 1 mark 
It is only acceptable to use a lookup from a value 
list for Restricted Choice validation in Access if 
there is an accompanying Validation Rule or the 
“Limit to List” option has been set to True. 

 Links between tables 2,1,0 3 correct 1 to many relationships – 2 marks 
2 correct – 1 mark  
otherwise – 0 marks 

1,0 Calculated field for each order line (Quantity x Price) 
1,0 Summary field (SUM) for each order 

Computed and summary 
fields 

1,0 Summary field (SUM) for all orders 
1,0 Data sorted by OrderDate Descending 

3 

Report layout 
1,0 Similar layout to sample, all text visible 
1,0 Order totals correct 
1,0 Discount totals correct 

4 Order details 

1,0 Totals after discount correct 
2,1,0 Summary totals correct  Summary fields 

1,0 Count function correct 
 Report Layout 2,1,0 Data sorted OrderDate Ascending, OrderNo 

Ascending 
1,0 Category selection form Forms created 
1,0 Single item category form 

5 

Navigation features 3,2,1,0 Macro/scripts to close Category Select form and 
open Item form and macro/script to close Item form 
and open Category select form – deduct 1 mark each 
omission 
The macro/script evidence MUST show both the 
close and open operation applied to each 
navigational feature. 
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Software functionality 2,1,0 Comparison of 2 features of each type of software 

to produce newsletter – 2 marks 
Comparison of only 1 feature of each type – 1 mark 

6(a) 

Software usability 2,1,0 Comparison of 2 features that contribute to the 
usability of each type of software – 2 marks 
Comparison of only 1 feature that contributes to the 
usability of each type of software – 1 mark 

1,0 Printout showing field markers 6(b) Personalised newsletter 
1,0 Printout showing sample customer 
1,0 Sans serif font consistently used throughout 
1,0 Headline on each article 
1,0 1st paragraphs 14 or 16pt size; and drop cap 

 Consistent House Style 

1,0 Main body text 12pt size; sans serif 
1,0 Text wrap round graphics 
1,0 Use columns (watch uneven use of text boxes) 

 Newsletter layout 

1,0 General layout/white space 
 Article 1 4,3,2,1,0 Include 2 products from items table – 1 mark 

Include 2 suitable graphics – 1 mark 
Graphics wrapped within the text – 1 mark 
Set within the promotion scenario – 1 mark 

 Article 2 4,3,2,1,0 Full explanations of 3 main points (cost savings to 
customers, 24/7 operation, efficiency, speed, 
accuracy etc) – 4 marks 
Less detailed explanations OR fewer issues 
discussed – 2/3 marks 
Only brief explanation provided – 1 mark 

1,0 5 data items/columns 
(Year, Branches, Costs, Revenue, Profit) 

1,0 Profit correctly calculated 

7(a) Table 

1,0 6 years data included 
2,1,0 All required data (deduct 1 mark any omission) 7(b) Table 
1,0 Table suitably labelled.   
1,0 More orders with discount promotion 
1,0 Less total revenue after discount (must compare 

Net revenue for Jan 08 with Total revenue for Jan 
07) 

 Concluding statement 

1,0 Repeat offer but reduce discount from 20% 
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Appendix 5 
 
 
 
 
 
 
 
Screenshots showing solutions to Tasks 3, 4 and 7 
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Task 3 
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Task 4 
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Task 7 (a) – Table 1 
 

Year Branches Costs (£) Revenue(£) Profit(£)
2002 35 700000 763000 63000
2003 25 595000 824040 229040
2004 20 500000 900000 400000
2005 8 250000 760000 510000
2006 1 90250 795000 704750
2007 1 114000 865000 751000

 
 
Task 7 (b) – Table 1 
 
 
 

January Promotions 
 
 2007 2008 

Orders Placed 6 10 

Total Revenue £496.00 £550.00 

Total Discount N/A £110.00 

Net Revenue N/A £440.00 

 
 

   
 
  


